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Installing I BI S

Install Directions - Mac OS X:
Download IBIS using the link emailed to you when you requested IBIS. Once the download is 
complete, open your Downloads folder and �nd the IBIS-MacOSX folder. Drag this folder into 
the Applications folder (listed on the le� hand side of the window). Go to your Applications folder, 
open the IBIS folder, and double click on IBIS. 

If you get a message warning you that the application source is not trusted, then you'll need to 
right-click (two-�nger click) on the application, and select Open. When you get a warning, press 
open again. From now on, it’ll open normally.

Once IBIS is open, read (and scroll to the bottom of ) the License Agreement, and press Agree. 
Next, type in the serial number listed in the email you received (don’t copy and paste it). Enjoy!

Install Directions - Windows:
Download IBIS using the link emailed to you when you requested IBIS. Once it's done, open the 
windows.zip �le in your downloads folder. Drag the contents to your desktop. Open that folder, 
and double click IBIS.exe. Read (and scroll to the bottom of ) the License Agreement, and press 
Agree. Next, type in the serial number shown above (don’t copy and paste it). Enjoy!
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IBIS is comprised of four main modules:
• Therapeutics files contain comprehensive listings of treatment/therapeutic options for the conditions covered by IBIS.
• Materia Medica is a vast encyclopedia that gives information about the therapeutic substances and techniques found in

the Therapeutics files.  It also includes essays on the principles and philosophy of the various therapeutic techniques, as
well as useful patient handouts.

• The Notebook module allows you to add your own information to IBIS in the form of Notes.
• Patients and Visits enables you to record and analyze information about your patients, the progression of their treatments,

and the effectiveness of the therapies you provide.

You may launch any module by clicking its corresponding button at the top of the Table of Contents.
From the Table of Contents, you can scan and open the conditions and topics contained in the Therapeutics, Materia Medica

and Notebook modules:

Select a module from the Table of Contents pull-down window.
The Therapeutics and Materia Medica Tables of Contents are each composed of two fields: 

- Therapeutics  -  a list of body systems and conditions
- Materia Medica  -  a list of categories and topics

• Click on a body system or category to see the list of conditions or topics it contains.
• Double-click on a condition or topic to view the corresponding text.

In the Therapeutics Table of Contents, a list of body systems appears in the systems field.  The conditions field shows a list of
conditions affecting the selected body system.

• Click on a body system to see the related conditions, or to view a list of all conditions, select All from the systems field.
• The information presented will be in the context of the selected modality (choose from the Modality pull-down menu).

However, you can easily switch between modalities from within the Therapeutics module by simply clicking on the
desired modality button.

• Double-click on a condition to view it.

In the Materia Medica Table of Contents, the categories all relate to the selected modality.
• Choose a modality from the Modality pull-down menu, or to view a list of all categories from all modalites, select All.
• Double-click on a topic to view it.

The Notebook Table of Contents is simply a list of Notes organized according to each modality.  To locate and open a Note:
• Choose a modality from the Modality pull-down menu.
• Double-click on a topic to view it.

Getting Started:  The IBIS Table of Contents
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Using the Therapeutics Module
• The Conditions field displays the list of conditions to choose from.
• The System field lets you focus the Conditions list on a particular body system or a list of Chinese patterns.
• The body system options group the 282 conditions into 12 body systems.
• Selecting All in the System field gives you an alphabetical listing of all conditions for all body systems.
• Click on a condition to view the information.
• Click on a modality button (see top of page) to switch between the various therapeutic modalities.
• Note that each modality has a different set of subsection buttons below the Conditions list (e.g. for each condition, the

Somatic Therapies section is comprised of Movement, Manipulation, Hydrotherapy and Electrical/Oscillating sub-
sections).

Using the Materia Medica Module
• An alphabetical list of topics is found in the field labeled Topics by Category.  The topics in this list fall within the category

selected in the Category field above it.
• In the List Categories dialogue in the upper left, you can choose to view categories related only to the modality you select

by clicking on In Current Modality and then clicking on a modality button.
• Click on In All Modalities to view all categories.
• Click on a category to view the list of topics.
• Locate the topic of interest in the Topics field and click on it to view the file.

Using the Notebook Module
• The Notes are automatically sorted alphabetically and by modality so that you can easily refer to them.
• Click the Contents tab or the button labeled Show list of notebook pages to view the list of all Notes.
• Click on any title to view a Note.
• Use the right and left arrows at the bottom of the window to flip forward and backward through the Notes.
• To create a new Note, click on the button labeled Create a New Notebook Page or select New Note Page in the Options

pull-down menu.

Using the Patients and Visits Module
• The Patients button on the Table of Contents takes you to an index of the patients who have been entered into the

Patients and Visits Records.
• Each patient has a file that summarizes his/her previous visits.
• The Index of All Visits button chronologically lists all the visits you have entered into the system.
• The Outcomes Analysis button allows you to conduct office-based clinical outcome studies by analyzing the information

that you have entered into the Patient Visit files.

IBIS Modules and Modalities:  A General Overview

Diagnoses Nutrition (selected) Chinese Formulae Homeopathy Mind/Body

Somatic Therapies Botanicals Acupuncture Subtle Support Integrative
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Find
Use this tool to search through the  IBIS files for the text
you specify.

• Access Find by clicking on Find in Title in the Go
pull-down 

menu or by pressing Ctrl+F (Windows) or �+F
(MacOS).

• Enter the word(s) you wish to find in the open field.
• Indicate the module you wish to search in by selecting from the Section pull-down list.
• Indicate the modality you wish to search in by selecting from the Modality pull-down list.
• Click on the Find Next button to locate the text you have entered.
• Clicking again on Find Next will take you to any subsequent occurrences of your word(s).

Search
This tool allows you to search for words and phrases with-
in IBIS.  When you search for a word or phrase, IBIS
makes an Index of all files that contain the word(s) or
phrase.  Once an Index has been created, you can move
directly to a listed file by double-clicking with your mouse
on the title of the file.  The Index may also be saved for
later use and you can do searches within a saved index.

• Access Search by clicking on Search in the Go pull-
down menu or by pressing Ctrl+H (Windows) or
�+H (MacOS).

• Select the domain you wish to search:  To search one
or more IBIS modules, click on the module icon(s) of
your choice.  Selected modules will appear depressed.  Click again on a selected module to deselect it.

• Define the search criteria:  In the leftmost field, select a focus for your search.  These may be topics, categories, body text,
modalities, media types, comments and more.  The options in this field are defined by the domain you selected above.

• In the center field, choose whether to search for files that do or do not meet the criterion you are defining.
• In the rightmost field, enter the word or phrase which is the focus of your search, or choose from the list provided.
• Click on the Add button to add this criterion to your search.
• Repeat the above procedure to add additional criteria to narrow your search.
• To remove a criterion, highlight the line by clicking with your mouse, then click on the Remove button.
• When all search criteria have been defined, click on the Search button.  The search process may take a short while,

depending on the extent of the search.  When the search is complete, IBIS will switch to the View the Results section
where you will see the list of files alphabetically by topic, click on the Topic heading.

• Double-click on any line to view the file.
• To save the results of a search, select Save As from the File pull-down menu.  Type an appropriate filename and press

Enter.  You may later execute a search within this index by selecting Found Set in the Define the Search section and
choosing this file.

IBIS Tools
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Jump
This tool expedites cross-referencing between the
Materia Medica and Therapeutics modules.

• Simply use the mouse to highlight a term while
using one of these modules.

• Type Ctrl+J (Windows) or �+J (MacOS) or select
Jump in the Go pull-down menu.

• You will immediately be taken to the selected term
in the other module.

Comments
You can add your own comments to Therapeutics and
Materia Medica files.

• To add a comment, while viewing the file you
wish to comment on, simply click on the
Comments button at the lower left of the
Therapeutics or Materia Medica window.  Alternately, you may select Comments from the Go pull-down menu or press
Ctrl+T (Windows) or �+T (MacOS).

• Type your comment in the open field.
• When you are done, close the Comments box.
• Once you have added a comment to a file, the quill icon will appear above the name of the selected modality every time

this file is viewed to remind you of your comment.
• To view comments you have made, while viewing the appropriate file, simply re-open the Comments box by clicking on

the Comments button (or Ctrl+T or �+T or by selecting Comments from the Go pull-down menu) and close it when
you are finished.

• Note:  for each Therapeutics condition, a unique comments box exists for each separate modality.

Links
Connect IBIS files based on your own special needs, associations or patterns of use (e.g. from a Therapeutics file for a condi-
tion to a particular treatment element in the Materia Medica).

To create a new link between two files:
• Start by viewing one of the files that you wish to link.
• Open the Links pull-down menu and select New Link or simply click on the Links button.
• From the dialog box, choose a name for the link in the Link Name field.
• From the Section field, choose the module you wish to link to.
• From the Modality field, choose the modality of the file you wish to link to.
• From the Topic field, choose the Materia Medica or Notebook topic or Therapeutics condition.
• When you find the file you wish to link to, select Save.
• When a link has been made between files, the Links icon will appear above the name of the selected modality.
• To follow a link, open the Links pull-down menu and click on the link name to jump to the linked file.  You will immedi-

ately be taken to the other file.
• To delete a link you have made, click on the Links button, select the link you wish to delete from the Link Name field

and click on the Delete Link button.

IBIS Tools - continued
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1. The pull-down menus give you access to the tools, functions and modules discussed in this guide:
• The File pull-down menu has printing and saving options.
• The Edit pull-down menu lets you access copy and paste commands as well as the IBIS clipboard.
• The Go pull-down menu allows you to open the other modules and use the Find, Search, Jump and Comments tools.
• The Modality pull-down menu allows you to select a modality.
• The Links pull-down menu helps you create and edit links.
• The Help pull-down menu gives you access to IBIS help and information on registration, updates and more.

2. The Systems field allows you to focus the list of conditions on a particular body system or on Chinese patterns.  Use the
sidebar to scroll through the list.  To bypass this option and view a list of all conditions covered in IBIS, select All.

3. The Conditions field displays a list of conditions from which to choose.  Use the sidebar to scroll through the list.  Click
on a condition to view the text.

4. Each modality presents you with a different set of sub-section buttons located below the conditions field (e.g. Botanicals
is divided into Single Herbs, Formulae and Footnotes).  Click on a button to view the related text.

5. When viewing a topic in Botanicals, the Common Names button appears.  Click on this button to cross-index common
and botanical names.

6. Click on the Sources button to view the bibliography for that modality.
7. Use the Modality buttons to select from the different therapeutic approaches.  Once a condition is selected, you can

switch between the various modalities simply by clicking on these buttons.
8. The current condition name is shown above the main text field.  Pull down this tab for a list of the conditions you

viewed recently.  Click on any condition name in this list to reopen it.
9. The Text field displays the therapeutic information for the condition and modality that you select.
10. The Comments button enables you to locally add comments to the current condition.  See the section on using this tool

for more details.
11. The Links button allows you to connect IBIS files to reflect your own train of thought and patterns of usage.  Click on

this button to create a link between the open Therapeutics topic and any other topic in the Notebook, Materia Medica or
Therapeutics modules.  See the section on using this tool for more details.

12. Click on the Find button to access the find tools.
13. If a picture tab appears above the main text field, you can click it to display an associated graphic resource.

IBIS Therapeutics Module

1
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1. The pull-down menus give you access to the tools, functions and modules discussed in the Therapeutics Module.
2. By clicking on the In Current Modality button, you can elect to focus the list of categories on only those which pertain to

the selected modality.  To view a list of all categories, regardless of modality, select In All Modalities.
3. The Categories field displays a list of categories, each of which contains a number of topics (shown below it in the topics

field).  Click on a category to display the relevant topics in the topics field.
4. The Topics field shows the list of IBIS Materia Medica topics.  Click on any topic to view the text.
5. The Text and Footnotes buttons let you switch between the body text and the footnote for any topic.
6. Click on the Sources button to view the bibliography.
7. Use the modality buttons to select from the different therapeutic models.  
8. The current condition name is shown above the main text field.  Pull down this tab for a list of the topics you viewed

previously.  Click on any topic in this list to reopen it.
9. The Text field displays the therapeutic information for the condition and modality that you select.
10. The IBIS logo icon will return you to the Table of Contents.
11. The Comments button lets you add your own comments to any topic.  See the section on using this tool for more

details.
12. The Links button allows you to join IBIS topics to develop your own train of thought.  Click on this button to create a

link between the open Materia Medica topic and any other topic in the Notebook, Materia Medica or Therapeutics mod-
ules.  See the section on using this tool for more details.

13. Click on the Find button to access the find tools.
14. If a picture tab appears above the main text field, you can click it to display an associated graphic resource.

IBIS Materia Medica Module
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1. The pull-down menus give you access to the tools and functions needed in the Notebook Module.
• The File pull-down menu has print, save and import/export options.
• The Edit pull-down menu lets you access copy and paste commands, add/delete a notebook page and the IBIS clip-

board.
• The Go pull-down menu allows you to open the other modules and use the Find and Search tools.
• The Links pull-down menu lets you create and edit links.
• The Font pull-down menu provides a listing of available fonts.
• The Size pull-down menu show a listing of available font sizes.
• The Style pull-down menu allows you to add styled fonts to your notecards.
• The Help pull-down menu gives you access to IBIS help and information on registration, updates and more.

2. Click on this button to return to the list of notebook pages.
3. Click on this button to create a new notebook page.  A blank notebook page will appear.  Type the title in the title field

and the body text in the text field.  Select the modality under which you which to classify your new note.  Type your
name in the Contributor field.  Finally, enter the source of the information in the Source field.  When you are finished,
open the File pull-down menu and click on Save.

4. The links button allows you to join IBIS topics to follow your own train of thought and patterns of usage.  Click on this
button to create a link between the open Notebook page and any other topic in the Notebook, Materia Medica or
Therapeutics modules.  See the section on using this tool for more details.

5. Click on the find button to access the find tools.
6. Use the modality buttons to select from the different therapeutic models.  When viewing the list of Notebook pages, click

on a modality button to see the topics related to a particular modality.  When viewing a Notebook page, clicking on a
new modality switches you to the first page classified in that modality.

7. The title of the open Notebook page is shown above the text field.
8. The text field displays the body of the Notebook page you select.
9. The Source field shows bibliographic information for the open Notebook page.
10. The Contributor field displays the name(s) of the person(s) responsible for entering the current Notebook page into IBIS.
11. The modality field indicates the modality under which the open Notebook page is classified.  You may change the modal-

ity of a saved Notebook page by selecting a new modality from this list.
12. Use the left arrow and right arrow buttons to flip through the Notebook pages in the selected modality.

IBIS Notebook Module
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Patient Index

1. The main field displays a list of all patients you have entered in IBIS.  Double-click on any patients' name to access their
Patient Record.

2. The pull-down menus give you access to additional functions.  Of note is the File menu, which contains options to
Import, Export, Remove and Save Patient Records.

3. Click on the Add Patient button to enter data on a new patient.  You will be presented with a blank patient record.
4. Clicking on the Delete Patient button will permanently remove the patient you have highlighted with the mouse.
5. The Index of Patients button displays the list of all entered patients.  Click on any name in the list to open the associated

Patient Record.  This is the current screen.
6. The Index of All Visits button displays a list of all Visit Records you have entered, grouped by patient.  Click on any visit

in the list to open the Visit Record.
7. Click on the printer icon to print the displayed page. 
8. Click on the Outcomes Analysis button to conduct analysis of patient and visit data.  This tool will be discussed in

greater detail later in this section.
9. Click on the find button to access the find tools for the other modules; this does not include finds within the Patients

and Visits Module.

IBIS Patients and Visits Module
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Patient Record

1. The pull-down menus give you access to the tools, functions and modules discussed in the Therapeutics Module.
2. Click on any name in the List of Patients to open their Patient Record.
3. Click on Male or Female to indicate the patient's gender.
4. Click on the Add Patient button to enter a new Patient Record.
5. Click on the Delete Patient button to permanently delete the open Patient Record.
6. Click on the Index of Patients button to return to the Index of Patients to display the list all entered patients.  Click on

any name in the list to open the associated Patient Record.
7. The Index of All Visits button displays a list of all Visit Records you have entered, grouped by patient.  Click on any visit

in the list to open the Visit Record.
8. The Patient tab is normally selected when you open a Patient Record.  This section of the record contains personal infor-

mation about the patient.
9. Click on the Treatment Plan tab to record notes on this patient's treatment.
10. Click on the Visit History tab to view a list of all visits you have entered for this patient.  Click on any visit in the list to

open the record for that visit.
11. Enter the patient's first and last name in the designated fields.
12. Enter the patient's birth date in the format MONTH/DAY/YEAR.  Press Enter or Return.
13. Enter the patient's ethnic background here.  Use the pull-down list for quick access to previously entered ethnicities.
14. Enter the city, state and country of the patient's current residence here.
15. Enter the patient's birthplace here.
16. Create two of your own Patient Variables.  Double-click here to name a variable.  In the pop-up window, type the label

for this variable (example: Number of Children or Marital Status).
17. Enter responses for the variables you created here.  These responses can be either numerical (such as "2" in response to

"Number of Children") or textual (such as "Divorced" in response to "Marital Status").  Use the pull-down lists for quick
access to previously entered responses.

18. Click on the printer icon to print the displayed page.
19. Click on the Outcomes Analysis button to conduct analysis of patient and visit data.  This tool will be discussed in

IBIS Patients and Visits Module - continued
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greater detail later in this section.
20. Click on the find button to access the find tools (This does not include finds within the Patients and Visits Module).
21. In the Practitioner field, enter the name of the practitioner treating this patient.  Use the pull-down list for quick access

of names you have entered.
22. Click on the Add Visit button to add a Visit Record for the current patient.
23. The First Visit field indicates the date of the first recorded visit for this patient.

Visit Record

1. The pull-down menus give you access to the tools, functions and modules discussed in the Therapeutics Module.
2. Click on the Patient button to open the Patient Record for the current patient.
3. The patient's name, randomly-assigned Patient ID number and gender are indicated here.
4. Click on the by visit button to display the patient's list of visits (below) chronologically by date of visit.  Click on the by

condition button to group the visits alphabetically by the (first) condition being treated.
5. The visits field displays a list of all entered visits for this patient.  Click on a visit to open the Visit Record.
6. Click on the Add Visit button to add a Visit Record for the current patient.
7. Click on the Delete Visit button to delete a Visit Record for the current patient.
8. The Index of Patients button displays the list all entered patients.  Click on any name in the list to open the associated

Patient Record.
9. The Index of All Visits button displays a list of all Visit Records you have entered, grouped by patient.  Click on any visit

in the list to open the Visit Record. 
10. The Evaluation tab displays the shown section of Visit Record.
11. Click on the Treatment tab to view and enter specific treatment items prescribed on this visit.
12. Click on the Chart Notes tab to view and enter notes on this visit.

IBIS Patients and Visits Module - continued
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13. In the Practitioner field, enter the name of the practitioner treating this patient.  Use the pull-down list for quick access
of names you have entered.

14. This field displays the date of the current Visit Record.
15. Enter two of the patient's conditions here.  First select the body system affected or choose all systems to select from a list of

all conditions.
16. Indicate the patient's condition by selecting from this list.  Your selection will appear in the field below.  Alternately, you

may type the name of the patient's condition in the field below.
17. If you selected from the list of conditions above, the condition will appear in this field.  You may also type the condition

directly into this field.
18. If you use diagnostic codes (e.g. insurance purposes), you may enter the proper code in the Diagnostic Code field.  Use

the pull-down list for quick access to commonly used codes.
19. Enter the date of resolution of the condition here (if resolved).
20. Enter the date of onset of the condition here, in the format MONTH/DAY/YEAR.  Press Enter or Return.
21. For the purpose of recording other factors you may wish to analyze, you are provided with two Visit Variables.  User-

Defined Visit Variable 1: Double-click on this heading to enter your own variable.  It is best to select a variable that can
be indicated by sliding scale for this variable (such as Energy Level or Work Stress), since the value must fall on the scale
from -5 to +5.  Next, indicate a response value for this variable by dragging the sliding bar or by typing a value from -5 to
+5 in the field.

22. User-Defined Visit Variable 2: Double-click on this heading to enter your own variable, then indicate a response value in
the field below.  Use the pull-down list to quickly access values you have entered previously.  Note:  The response value
may be either numerical or textual.

23. Indicate how much the patient participated in developing the treatment plan.  This function allows you to test whether a
patient's enthusiasm or hesitation in choosing a therapeutic path is a significant factor in its success.  Rate the patient
from -2 (unwilling to participate) to +2 (actively involved) by dragging the sliding bar or by typing the value in this field. 

24. The Subsequent Change field is to compare follow-up visits.  If the patient has made a follow-up visit, you can use this
section to measure the results of the treatments prescribed.  Drag the sliding bars or enter a value to indicate change on a
scale from -2 (considerable decline) to +2 (considerable improvement) for conditions 1 and 2 and overall change.  Next
indicate the patient's compliance with the treatment plan.

25. Click on the printer icon to print the displayed page.
26. Click on the Outcomes Analysis button to conduct analysis of patient and visit data.  This tool will be discussed in

greater detail later in this section.
27. Click on the Find button to access the find tools (This does not include finds within the Patients and Visits Module).
28. When indicating subsequent change, enter the date of the return visit here.
29. Indicate the patient's perception of their feeling and function by dragging the sliding bars or typing in.  The range is

from -5 (worst) to +5 (best) for each visit.
30. Indicate the practitioner's perception of the patient's feeling and function by dragging the sliding bars or typing in.  The

range is from -5 (worst) to +5 (best) for each.
31. Click on Clone This Visit button to produce a second copy of this Visit Record on which to record additional informa-

tion or to save time in creating a Visit Record with similar values.
32. Click on the Print This Visit button to print a copy of this Visit Record.

Note:  You are advised to review the related topics in the Help Section within IBIS for further information on the use of this
module.

IBIS Patients and Visits Module - continued
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Outcomes Analysis

1. Clicking on the Define the Search tab brings you to the section shown.  Set the parameters of your search here.
2. Select parameter for analysis: Use the pull-down lists to define criteria for inclusion in (or exclusion from) the collected

set.  The first list contains patient and visit variable.  The second list contains qualifiers such as "is," "is not," "is greater
than," etc.  The third list contains values such as "male," "Asian," "Seattle," etc.  Combine terms from each list to create
search parameters.  Example:  Gender is male or Practitioner is not Dr. Welby.  Each parameter you define must be added to
the list of search parameters by clicking on the Add button.

3. The main field shows all parameters added to the search.  The search will turn up only those records that meet all of the
defined criteria.

4. Select fields to view in the results: Choose up to six fields to view from the records collected by the search.  Use the pull-
down lists to select from the patient and visit variables.

5. For each search parameter you define, click on the Add button to add it to the list of search parameters below.
6. To remove a criterion from the list of search parameters, highlight the entry with your mouse, then click on the Remove

button.
7. Click on the Reset Search button to clear this form.
8. When you have added all of your search parameters, click on the Search button to execute the search.
9. To exit the Outcomes Analysis section, click on the Done button.
10. Once you have executed your search, click on the View the Results tab to display the records that meet your search crite-

ria.  Click on any record in this list to view the associated Visit Record.
11. Click on the View Averages tab to display gender statistics and averages of all sliding scale variables (patient and practi-

tioner feeling and function, subsequent change, patient participation and visit variable 1) for Visit Records collected by
your search.

IBIS Patients and Visits Module - continued
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Treatment Record

1. For each treatment item, use the pull-down menu to select a modality under which to classify it.
2. In the Treatment Items field enter a substance, exercise or procedure.
3. Use the Dosage field to indicate the dosage prescribed (where applicable).  You may type dosage information directly into

this field or you may select from the pull-down lists.
4. Use the Frequency field to indicate frequency of administration of the treatment item.  You may type this information

directly into this field or you may select from the pull-down lists.
5. When you have entered the treatment item, dosage and frequency values, click on the Add to Treatment List to add this

treatment to the Treatments for This Visit list.
6. Click on the Clear button to erase any information entered into this form.
7. The Treatments for This Visit field lists all treatments you have added.
8. Click on this button to Print or Copy the list of treatments for this visit.
9. To replace one treatment in the list of Treatments for This Visit with another, enter the new treatment information,

highlight the treatment you wish to replace in the Treatments for This Visit list, and click on the Replace Selected
Treatment button.

10. To delete a treatment you have added, highlight the treatment in the Treatments for This Visit list and click on the Delete
Treatment button.

11. To edit a treatment you have added, highlight the treatment in the Treatments for This Visit list, then click the Edit
Treatment button.  The treatment item, dosage and frequency values will appear in the selection fields where you may
alter them, and, if you desire, replace the original treatment (using the Replace button).

IBIS Patients and Visits Module - continued
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The following commands are executed by
pressing the Control key (Windows) or the
Command � key (Macintosh) plus the indi-
cated number or letter:

0 Open IBIS Table of
Contents

1 Open Therapeutics
module

2 Open Materia Medica
module

3 Open Notebook module

4 Open Patients & Visits
module

C Copy selected text

E Export a Note

F Find tool

H Search tool

I Import IBIS data to the
Notebook

J Jump tool

K Copy selected text to
IBIS Clipboard

L Show IBIS Clipboard

N Create new Note

P Print text

S Save text as...

T Add and view Comments

V Paste copied text

X Cut selected text

Quick Key Commands MedicineWorks.com
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